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Smart View Training Guide

This training guide has been created to enable users to input their budget into C-BIG through the Smart View add-
in. If any questions come up during your review of the information, please feel free to contact APB’s Hyperion
Planning Analyst, Cathy Son, at cson@ponet.ucla.edu or x53833.

Smart View Overview

e Microsoft Office add-in for Oracle Hyperion Planning applications

o Allows users to input data through templates created for C-BIG

e Provides ad-hoc query capability to users in a familiar Excel environment

o Allows users to dynamically access the live data and develop their own queries
o Allows users to pull CBIG reports to manipulate in Excel

Installing Smart View

To begin, first install Smart View (with the help of your IT team, if needed).

1. To download, go to the APB C-BIG webpage and click the Download Smart View! link.

2. Download and install - be sure to right-click the .exe file and select Run as Administrator when
installing.

3. Open Excel and verify that the Smart View tab is there.

If there are other Excel Add-ins installed, you may need to disable them for
Smart View to run properly (i.e. Acrobat PDFMaker Office COM Addin). Go
to File > Options > Add-Ins > Excel Add-ins > Go... and uncheck add-ins you
would like to disable (see image below).

If Smart View is installed, but does not appear in Excel, make sure Oracle
Smart View for Office is checked under both Excel Add-ins and COM Add-
ins.


mailto:cson@ponet.ucla.edu
http://www.apb.ucla.edu/resource-management/c-big

Excel Options

G | . . .
enera E‘B View and manage Microsoft Office Add-ins.
Formulas
Proofing Add-ins
Save Name Location Type a
Language Active Application Add-ins
Acrobat PDFMaker Office COM Addin C\..5\PDFMaker\Office\PDFMOfficeAddin.dll COM Add-in
Advanced Oracle Smart View for Office C\Oracle\SmartView\bin\HsTbar.xla Excel Add-in
Customize Ribbon Oracle Smart View for Office C\Qracle\SmartView\bin\HsAddin.dll COM Add-in
Quick Access Toolbar Inactive Application Add-ins
Aakidis Analysis ToolPak C)\...Office15\Librany\Analysis\ANALYS32.XLL  Excel Add-in
Analysis ToolPak - VBA C)\...fice15\Library\Analysis\ATPVBAEN.XLAM  Excel Add-in he
Trust Center Add-in: Acrobat PDFMaker Office COM Addin
Publisher: Adobe Systems, Incorporated
Compatibility: Mo compatibility information available
Location: CM\Program Files (x86)\Adobe\Acrobat 2015\PDFMaker\Office\PDFMOfficeAddin.dll
Description:  Acrobat PDFMaker Office COM Addin
Manage: |Excel Add-ins v Go..

Setting Up Smart View Connection

1. After the installation of Smart View is complete, launch Microsoft Excel.

2. Select Smart View from the menu.
3. Inthe Smart View Ribbon, select Options:

= :
FILE HOME INSERT PAGE LAYOUT  FORMULAS DATA
= , 5 Undo Copy = o=
® | e & 1S
@ Redo Paste
Panel | Connections Refresh | Submit | Options

fane -
- Functions . Data

Start Edlit Data

4. Within the Options window, select Advanced.

VIEW

¢ Help -
&* Sheet Info
El More -

General

Cancel

SMART VIEW

5. Inthe Shared Connections URL section, copy the entire URL below and paste into the box:

https://finbud.it.ucla.edu/workspace/SmartViewProviders



https://finbud.it.ucla.edu/workspace/SmartViewProviders

Options x

[

Member Options o & Change global Smart View options. -

Data Options "
General .

Advanced chared Connections URL: | https://finbud.it.uda.edu: 1900[],,’workspace,.'5m;| - |

. Mumber of Undo Actions o

Formatting IS =i
Mumber of Most Recently Used items

Cell Styles %

Delete All MRU Items

6. Click OK.

If you receive the following message when trying to save your Options,

Note! . .
please create a log file by following the steps below:

Oracle Smart View for Office

S

'8 Failed to open message log file.:

OK

7. In Options > Advanced, check Route Messages to File option and click on the elipses icon to search for a file
location:



Options

Member Options
Data Options
Advanced
Formatting

Cell Styles

Extensions

Change global Smart View options.

General (i)

Shared Connections URL: http:Hchig.ais.ucla.edu:IQDDwaorkspacemeE| - |

Number of Undo Actions
Mumber of Most Recently Used items
Delete All MRU kems

Logging (i)

Log Message Display |Errors | - |

[+] Route Messages to File | |

[ ] clear Log File on Next Launch
[ ] show Diagnostics Group on Smart View Ribbon
Display (i)
Language English | - |

[ ] pisplay Smart View Shortcut Menus Only

[ ] pisable Smart View in Outlook

[+] Enable Ribbon Context Changing

[+] Disable options that are not valid for the active connection

[ ] isplay Drill-Through Report ToolTips

[ ] show Progress Information After (seconds) | :
Compatibility (i)
[+] Reduce Excel File Size

lmpro\.re Metadata Storage

[ ] Refresh Selected Functions and their dependents

Mode (i)

Use Double-click for Operations

8. At afolder/location of your choice, right-click and select New > Text Document.




Open

Contact

@ * 1 | <« Oracle » SmartView v | & | Search SmartView »p
Organize * New folder = [l @
” MName Date modified Type
& This PC
| extensions 8/3/2016 9:27 AM File folder
I Desktop
I Documents View >
Iy Downloads Sort by >
¥ Music Group by »
& Pictures Refresh
B Videos Paste
% Local Disk (C) Paste shortcut
& Undo Rename Ctrl+Z
¥ Share with r
F New *| | Folder
=4 Properties #] shortcut
v £ 2
¥ Microsoft Access Database
File name: W Bitmap image
(2=

Microsoft Word Document
Journal Document
Microsoft PowerPoint Presentation

Microsoft Publisher Document

Text Document P

Microsoft Excel Worksheet
Compressed (zipped) Folder

e E=

9. Name your document “SmartViewLog.log” and select Open.
10. Uncheck the Route Messages to File option and click OK > Save as Default Options:



Options

Member Options
Data Options
Advanced
Formatting

Cell Styles

Extensions

Change global Smart View options.

General

(0

Shared Connections URL:

http://cbig.ais.ucla.edu:19000/workspace/Smz

e |

Number of Undo Actions

Number of Most Recently Used items
Delete All MRU Items

Logging

o

Log Message Display | Errors

|v|

[]Route Messages to File

| C:\Usersh

'\AppData'\Roaming'\OracIe'\Smar‘t‘.’ie|

Clear Log File on Next Launch
[ ] show Diagnostics Group on Smart View Ribbon

Display

Language English

|:| Display Smart View Shortcut Menus Only

[ | pisable Smart View in Outlook

Enable Ribbon Context Changing

Disable options that are not valid for the active connection
[ ] pisplay Drill-Through Report ToolTips

[ ] show Progress Information After (seconds)
Compatibility

Reduce Excel File Size

Improve Metadata Storage

|:| Refresh Selected Functions and their dependents

Help Reset

Connecting to Smart View

1. Click on the Smart View Ribbon.

2. Click on Panel.

B o

41

HOME INSERT
c E) Undo
& Redo
Connections
Start

PAGE LAYOUT FORMULAS DATA
Copy & 8=
& @ o=
Paste

Refresh | Submit | Options
- Data
Data

Functions ~

Edit

Cancel

Save as Default Options

[y

Apply to All Sheets

REVIEW  VIEW

? Help ~
&" Sheet Info
E More -

General

SMART VIEW



3. Inthe Smart View panel, click on Shared Connections.

Smart View v o

Smart View Home ff « »

> Shared Connections

Connections from shared repository

B Private Connections

Locally defined connections and
shortcuts to shared connections

4. Enter your User Name and Password and click Connect:

Connect to Data Source ?

_}E User Authentication Needed.
) Enter correctusername and password to sign on.

User Name: testucla
Password: | T
Cancel Details <<
URL http://cbig.ais.ucla.edu:19000/workspace/SmartViewPr
Provider Oracle Enterprise Performance Management System W

5. Under Shared Connections, click on the dropdown that says "Select Server to proceed" and click Oracle
Hyperion Planning, Fusion Edition:

Smart View v
Shared Connections ff « »
‘ Select Server to proceed | | F -

Oracle® Essbase
| Oracle® Hyperion Planning, Fusion Edition I
Reporting and Analysis Framewaor!

1

Setting Smart View User Options

1. From the Excel ribbon, click the Smart View tab.
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2. From the Smart View tab, click the Options icon:

= 5

FILE HOME  INSERT

= c ) Undo
-

Panel

PAGE LAYOUT  FORMULAS

&

Refresh | Submit
= Data
Data

DATA  REVIEW

Copy
Paste
Functions -

@ Redo
Connections

-

Start Edit

General

3. Select Data Options and deselect all suppression options.
4. Change the #NoData/Missing Label to a dash, blank, or O (zero):

Options

VIEW

SMART VIEW

Member Options
=l
Data Options

Adva i Suppress Rows

[ Ino pata / Missing

|:|Ze-r0

|:| Mo Access

[ ]mvalid

[ Junderscore Characters

Formatting
Cell Styles

Extensions

[ |Repeated Members

Suppress Columns

[ ]no Data / Missing

[zero ()
[ |no Access (1)

Replacement

< 1 Change Smart View options related to grid rows and columns.

I #MoData/Missing Label:

#MNoAccess Label: #No Access

#Invalid/Meaningless: | #Invalid

Submit zero
[ | pisplay Invalid Data
Enable Essbase Format String

Mode

Cell Display Data

[ Inavigate Without Data

[_] suppress Missing blocks

Help Reset

5. Inthe Options, select Formatting and select the Adjust Column Width option.

11
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6. Once the Smart View Options have been set, click the drop down arrow next to the OK button.
7. Click Save as Default Options:

Cancel

I Save as Default Options I

Apply to All Sheets

METHOD 1: Use Smart View to Pull Reports & Input Forms

There are usually two different ways to get to the same thing in Smart View. This is the first method which
allows the user to pull everything into Smart View.

To view the Org/Dept Fund Check Report (or any other report),

1. Under Shared Connections, click on the dropdown that says "Select Server to proceed" and click

Reporting and Analysis Framework
2. Follow the path below to get to 15 Bud Input — Org & Fund Check and double-click the report:

%Er?ﬂa t View v X
Shared Connections o »
I Reporting and Analysis Framework I | - | =+ -

= @ http:ffchig.ais.uda. edu: 19000 raframework browse flistxML
[ﬁ] Broadcast Messages
&[] Crystal Ball Workbooks
-] Sample Content
[ﬁ] Shared Workspace Pages
&[] System
=-(7 UCLA
#-[F] 01 Analysis Reports
= [[] 02 Budget Input Reports
[f_':l Final
I 15 Bud Input - Org & Fund Check I
16 Bud Input Prelim - Budget & Actual - 3 ¥
17a Bud Input Prelim - Beg Balance
17b Bud Input Prelim - Beg Balance w Detail {15
17c Bud Input Prelim - Beg Balance w Detail (MU

A4ri- ML d T L e [ NS | N S

3. Enter your organization or department in the format “org_####” or “dpt_####" and click OK to preview

the report.
4. Then click Finish to pull the report into Excel.

For more information about opening reports in Smart View, see the Formatted Reports via Smart View Training
Manual (found on the C-BIG webpage).

12
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To pull the budget input forms,

5. Under Shared Connections, click on the dropdown that says "Select Server to proceed" and click Oracle
Hyperion Planning, Fusion Edition:

Smart View M
Shared Connections ff « »
‘ Select Server to proceed | | F -

Oracle® Essbase
| Oracle® Hyperion Planning, Fusion Edition I
Reporting and Analysis Framewaor!

1

6. Follow the path below to open the Beginning Budget Form and Budget Seasonality Forms (quarterly or
monthly — choose one):

Smart View =
Shared Ccrllgectinns a ~»
| Oracdle® Hyperion Planning, Fusion Edition | - | + -

=& chig.ais.uda.edu
- UCLA
= [l -Budgat Enrms
4 01. Budget Beginning Budget Form
4E 02a. Budget Seasonality Quarterly Form
4E 02b. Budget Seasonality Monthly Farm
----- = 03 f]rganizatinn Seasonality Form
i..[E] FY18 Budget Seasonality Monthly Form
[ Task Lists
- g Budget
-yt Employee
i Plan
-\ CEIGRptg

7. Double click to open a form:

13



Build Beginning Budget Form:

|

Note: Historical actual and budget numbers will show on this form — this form is blank for the purpose of not
displaying any department’s numbers

14



Budget Seasonality Form (Quarterly or Monthly):

POV 02a. Budget Seasonality Quarterly Form - cbig.ais.ucla.edu_UCLA 1

DELETE - DEPT 0320 (0320) ‘v || GENERAL FUNDS (19900) | - H Refresh |

Al - Fe
A
2
3
4
5 Perm Approp
6 | Temp Approp
7 |-Total Revenue
8 Faculty Ladder
9 Faculty Temporary
10 Academic Apprentice
1 Academic Other
12 Career Staff
13 Non-Career Staff
14 -Total Salaries & Wages
15 Medical (Health/Dental/Vision)
16 UCRS (Employer Contribution)
17 All Other Benefits
18 CBR
13 -Subtotal Benefits
20 Fee Remissions
21 Fee Remissions Adjustments
22 -Total Benefits
23 -Total Compensation
24 Material and Supplies - General
25 Material and Supplies - Scientific
26 Communications
27 Travel and Entertainment
28 Services
29 Consultants/Temp. Services
30 Information Technology
31 Equipment (non computer)
32 Operation and Maintenance of Space
33 Student Support - Underg & Grad
34 Other Expense - Control
35 Reserves for Auxiliaries
36 Indirect Cost Recovery
37 -Total Operating Expenses
38 | -Total Compensation and Operating
39 Recharges
40 | -Total Expenditures

41 -Surplus/(Deficit)
42 |Carryforward
43 Ending Balance

44

B C D E F G
FY 2018-19
o BegBalance

Beg Budget Adjustments Budget Cuts Program Chgs Chanc. Commit. Range/Merit/Infl.

H J N R \i z AL AB
FY19 vs FY18 Budget
To-Be-Spread YearTotal +Q1 +Q2 +Q3 +04 $Variance % Variance

. Total Budget

Budget

Budget Budget Budget Budget Proposed Budget Proposed Budget

cslolcslelololelolaloalslalelela|lsalsla|lololelclalolalclolalelalsalelelaloa

Note: Historical actual and budget numbers will show on this form — this form is blank for the purpose of not
displaying any department’s numbers

Use a new sheet to open multiple reports/forms in one Excel workbook.

METHOD 2: Reports and Input Forms through the Task List

The Task List is the second method to access reports and input forms. It opens the reports through the web
application.

1. Once connected to Oracle Hyperion Planning, Fusion Edition, drill into cbig.ais.ucla.edu > UCLA > Task
Lists > FYXX Budget Input Process and double click:

15



Smart View =

Shared Connections o v »

| Oracle Hyperion Planning, Fusion Edition | - ‘ R

=H= .ais.ucla.edu
£ @ UCLA
- Dimensions
--[EJ Farms
=7 Task Lists
L
FY18 Adj Budget Input Process
-4 Budget
-4 Employee
-4 Plan
-4 CBIGRptg

B-E-EE-

2. The Task List steps include the input forms and the approval process. Double-click on a task to begin:

Smart View v X
Task List B - »

Server: B Ais.ucla.edu
Annlication LICT A

FY18 Budget Input Process -

ek 1.0 Check CBIG Report - Dept Fund Check Report
O 2.0 Build Beginning Budget Form

O 3.0 Budget Seasonality Quarterly Form

-+ O 4.0 Budget Seasonality Monthly Form

-~ O 5.0 Check CBIG Report - Budget Check Spread Repa

The selected task will open. If the task is to view a report, the C-BIG webpage will appear and you will need to
log into the web to view the report.

If the selected task is to enter data in a form, the form will appear in the current Excel sheet.

Selecting your Entity and Fund

There are two drop-down menus on the input forms you have opened in Excel. The left drop-down menu allows
you to select your department, and the right drop-down menu allows you to select your fund. After changing
your selection, you must click the Refresh button to reflect the changes.

To change your department,

1. Select a department from the left drop-down menu and click Refresh:

16



@)@ &t Cell Actions - @8 Adjust - E More~ =i Save %E Approvals

e ==
& Lock ®y Drill-through = Clear & Copy Version
Analyze | Refresh | POM .
. B Calculate~ @ Submit Data &* Apply ~
Ad Hoc Data Formatting Workflow
POV 01. Budget Beginning Budget Form - adminbud.it.ucla.edu_UCLA 1
R - | ACADEMIC PLANNING & BUDGET (3815) | - H GENERAL FUNDS (19900) | 5 H Refreslkl
16 - I
A | B | C |D| E | F | G | H
1 FY 2014-15 FY 2015-16
3 Actual Approved Budget Actual
4 YearTotal YearTotal July August September October November Decen
5 Perm Approp

To change your fund,

2. Select a fund from the right drop-down menu and click Refresh.

To use the search feature,

1. Click in the department or fund drop-down menu.

2. Type one or more characters (alphanumeric) of the department or fund name for which you are
searching.

3. Select from the list that appears and then be sure to click Refresh.

POV 01. Budget Beginning Budget Form - adminbud.it.ygla.edu LICIA_1
i | ACADEMIC PLANNING & BUDGET (3815) [ ]| geneEIRMEEE
General Funds

16 - Jr

GENERAL FUNDS-IUCRP BIOTECHNOLOGY (19915)

GENERAL FUMDS-NRT GRAD & UNDERGRAD (19942)

A GENERAL FUNDS-NRT GRADUATE ACADEMIC (19943) H

1 IFY 2 GENERAL FUNDS-NRT GRADUATE PROFESSIONAL (19944) v 2015-16
3 T Actu GEMNERAL FUNDS-STIP INCOME (19901)
4 i Year] GENERAL FUNDS (19900) ber Novern
5 ] Perm Approp General Funds (UCLA)
6 TamE e GENERAL LIABILITY PROGRAM-UCOP (69907) 01 2
7 | -Total Revenue 01 25

Inputting and Submitting Budget Data

The cells with a grey background color represent read-only cells, while those with a light yellow background
color represent input cells. After inputting data, the cell color will change to dark yellow, indicating that data has
been changed but not yet submitted/saved to the database.

To submit/save your changes,

1. Click on Submit Data from the Planning ribbon:

17



FILE HOME  INSERT  PAGE LAYOUT  FORMULAS DATA  REVIEW  VIEW  SMART VIEW | PLANNING

@} Bl Cell Actions - @ Adjust - E More~ | & Save %2 Approvals
e | @ |I= _ _
& Lock o - 2 Clear =8 Copy Version
Analyze | Refresh | SPOY ;
' . B Calculate ~ || B8 Submit Data & Apply ~
Ad Hoc Data Formatting Workflow

2. If you get an error or the data will not submit (data disappears), please click Refresh and try again. If you
are still having problems submitting data, please reach out to Cathy Son (cson@ponet.ucla.edu).

If, instead of saving your data, you would like to delete your unsaved changes:

3. Click on Refresh from the Planning ribbon:

HOME  INSERT  PAGE LAYOUT  FORMULAS DATA  REVIEW  VIEW  SMART VIEW | PLANNING

Bl Cell Actions - @) Adjust - E More - | E Save 3E Approvals
— & Lock ®y Drill-through 2 Clear =3 Copy Version
Refresh § POV )
. B Calculate~ B Submit Data & Apply -
Ad Hoc Data Formatting Workflow

4. At the following prompt, click on the OK button to confirm the Refresh command:

Cracle Hyperion Smart View for Office, Fusion Edition Lﬂ

| ok || Cancel

Adding Cell Comments

To add Cell Comments,
1. Select a single cell or a range of contiguous cells.
2. Click on Cell Actions > Comments from the Planning ribbon:

18
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B & E -

m2 Cell Actions = 3 Adjust E N

|
L] @}@ Sall _
=| Comments ough

Analyze | Refresh || POV

¥

-

=
=]
=
(=]
=
S
ls]
]
@
)
141

Ad Hoc | B Attachment i
POV 01. Budget Beginning E@ .ucla.edu_U(

History
ACADEMIC PLANMING & BUC — _— IT‘ General F

g

3. Once the Comments window appears, click the + icon:

Comments - 0B

Entity: . Fund: GENERAL FUNDS (15500). Scenario: Current

M5 - Perm Approp. FY 2017-18, Working, Beg Budget, BegE v @3@ B8

User Date Entered Comments Add comment

Hide Intersection Apply to all selected cells Close

4. Enter comments (up to 2000 characters per each cell), then click Save then Close.

19



Comments - O

Entity: . Fund: GENERAL FUNDS (19900). Scenario: Current
M5 - Perm Approp. FY 2017-18. Working. Beg Budget, BegE ap E
User Date Entered Comments Sample comment

Hide Intersection [ | Apply to all selected cells Close

5. The cell will have a blue border, indicating that cell comments are present.

L M

FY 2017-18

Beg Budget

YTD (Jul:Feb) BegBalance
7120577
1419165
8539742
2401402
156018
203538
582611
228194

l=Ri=Ri=Rj=RieRl=Rle]

Adding Supporting Details

Supporting details are used to provide more detail behind a number. To add Supporting Details,

1. Select a single cell or a row of contiguous cells.
2. Click on Cell Actions > Supporting Details from the Planning ribbon:

20



FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW SMART VIE
([ = Cell Actions = @ Adjust - El More~ | = Save % Approvals
@ =

= o

= Comments irough 2 Clear k& Copy Version
Analyze | Refresh = POV = | - _
- I._El Supporting Details - D3t@ " Apply
Ad Hoc % Attachment Formatting Waorkflow
POV 02b. Budget Seasona . itl.ais.ucla.edu UCLA 1
@ History

|—|| GENERAL FUNDS (19900)

- : h 4 £. n

3. Select the Add Child button.

Supporting Details - 0O
« [T+ Fund: GENERAL FUNDS (19900)  ® Scenario: Current

* Object : Perm Approp

Expand E Collapse | * Add Child | # Add Sibling | X Delete X Delete All |

b
& Promote & Demote <+ MoveUp ** Move Down | # Duplicate Row 12 Fill |
Copy B Paste

4. Type a description over the default “Untitled”, select an operator, and enter an amount.

Expand B Collapse | + Add Child < Add Sibling | » Delete X Delete All |

& Promote & Demote {F Move Up £ Move Down | # Duplicate Row 12 Fill |
Copy B Paste

Milorking/FY 2017-18/BegBalance/Beq Budget Working/FY 2017-18/BegBalance/Adju
D r-Linetemi  + 5000

--------------------- Total: 5000

5. To add line items, select the Add Sibling button.

21



H Expand B Collapse | * Add Child | + Add Slbllng | > Delete X Delete All |

» Demaote i Move Up # Duplicate Row |
Copy
Working/FY 2017-18/BegBalance/Beg Budget Working/FY 2017-18/BegBalance/Adju
r-Linelteml + 3000
B [Huneitemz | + 10500

---------------------- Total: 15500

6. Type in a description, an operator, an amount for the additional rows and click on the Submit button
when done.

The total amount will display on your form, and the cell background color will appear in aqua blue, indicating
that there are Supporting Details.

BegBalance
Beg Budget Adjustments Budget Cuts Program Chgs Chanc.
Perm Approp 15500 0 0 0

Temp Approp 0 0 0 0
-Total Revenue 15500 0 0 0
Faculty Ladder 0 0 0 0

Faculty Temporary 0 0 0 0
Academic Apprentice 0 0 0 0

To delete Supporting Details, simply go to Cell Actions > Supporting Details > Delete or Delete All.

Adjust

One cell or a range of cells can be adjusted by value or fixed percentage. To use the adjust function, highlight the
cells you would like to change in a form, and in the Planning tab of Excel, go to Adjust > Adjust.

FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW  VIEW SMART VIEW PLANNING

] B2 Cell Actions - | =3 Adjust = E More~ = Save B3 Approvals
& @ = s :

= o

& Lock 83 Adiust = Clear = Copy Version
Analyze Refresh | POV 8 Calaul = & Apol
- alculate H  Grid Spread = (ATHER
Ad Hoc Data Formatting Worlflow

Select an adjustment option, enter the value or percentage, and then click Adjust Data.
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Adjust Data

Select cell(s) and use any of the following methods to change the
values in the cells

IZ:.:Z'Add fixed value to selected cell(s)

() Subtract fixed value from selected cell(s)
IZ:Z' Multiply selected cell(s) by a fixed value

() Divide selected cell(s) by a fixed value
() Increase selected cell(s) by fixed percentage

() Decrease selected cell(s) by fixed percentage

Adjust Data Cancel

Copying and Pasting

To copy and paste data from other Excel sheets, use Excel features (e.g. Ctrl ¢/x/v, dragging cell content, etc.).

If the cells that you are copying are protected, you may be prompted to first unprotect the sheet. Click the Review
tab > Unprotect Sheet before copying.

A REVIEW § VIEW SMART VIEW PLANNING

lg & Protect and Share Workbook

Unprotect | Protect Share -

) Show All Comments
/5 Show Ink

ents Changes

Applying Excel Formulas

The ability to apply Excel formulas to manipulate and analyze data is available. When applying Excel formulas,
keep the following in mind:

e You can create formulas inside or outside the data form’s grid

e You cannot create formulas on read-only cells or on cells that have Supporting Details

e Formulas are preserved upon saving or refreshing your data

e You must save workbook as an Excel file

e A separate sheet must exist for each department and fund combination containing formulas
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Running Calculations

Calculations, or business rules, are available for the forms in Smart View. There are three rules available from the
Beginning Budget Form and Budget Seasonality Form.

To access the business rules,

1. Right-click on a row within the form and select a calculation from the Smart View menu. This can also be
accessed by selecting Calculate > Rules on Form from the Planning ribbon.

Beginning Budget Form:

The business rules for the Build Beginning Budget Form will populate Salaries and Operational Expense rows on
the form. Users may right-click ANY of the rows (e.g. Faculty Ladder) and select a calculation to run for all the
Salaries and Operational Expense rows:

& | Temp Approp 156881 150634 10347 10571
7 |-Total Revenue 516759 531761 391474 10571
8 Faculty Lad % Cut
g Faculty Ter Fz Copy
il Academic iD Paste Options:
11 Academict .
12 Career Stal A 3060 321469 39077 28127
13 Non-Caree Paste Special... 1362 15486 -9324 3212
14 -Total Salari 4422 336955 29753 31340
15 Medical ( 7700 4487 4487
16 UCRS (Em 4631 5942 4303
17 All Other 4241 -400 1551
18 CBR Clear Contents 118791
19 -Subtotal B 6572 118791 10028 10341
20 Fee Remis: )
Filter »
21 Fee Remis:
22 TotalBenef 2" ' 6572 118791 10028 10341
23 -Total Compe £ Insert Comment 0994 455746 39731 41681
24 Material € = Format Cells.. 3425 404 438
25 Material anc 145
26 Communical 3844 2320 247 247
27 Travel and E 343
28 Services 4064 319 A68
28 Consultants, Smart View P By Expand/Collapse
30 Information 1ecnnology I .
= E— = B, Drill-through
quipment( (i 11 A 4§ -9,
32 Operation al | 8 Options...
33 Student Sup 1 cCopyFY16-17 Actuals
34 Other Expense - Control Copy FY17-18 Approved Budget
35 Reserves for Auxiliaries Comy P18 ActualF
= ct st
36 Indirect Cost Recovery =5 pamorees I
37 -Total Operating Expenses 3 Roll-Up Calc (Optional) 153
38 -Total Compensation and Operating 543004 461892 35943 42834
20 Rerharoac

Budget Seasonality Form:

Business rules available for the Budget Seasonality Quarterly/Monthly Form are run for selected rows.
Therefore, it is important that you right-click on the specific row you would like to alter.
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To apply the calculation to multiple rows, right-click on the appropriate subtotal/parent row, then select the
calculation (e.g. Selecting Total Salaries & Wages would apply the calculation to Faculty Ladder, Faculty
Temporary, Academic Apprentice, Academic Other, Career Staff, and Non-Career Staff rows).

POV 02a. Budget Seasonality Quarterlv Form - chinadmiti.ais.ucla.edu UCIA_1
[ & Ccut 19900) [-]
_ 8 Copy
Al17 M =
[ Paste Options:

-y

O
A Paste Special.. D E F

2
3 BegBalance
4 en Budget Cut Program C Chanc. ColRe
5 | Perm Approp Clear Contents 0 0 0 0
6 | Temp Approp 0 0 0 0
7 -Total Revenue Filter y 0 0 0 0
8 Faculty Ladder Sort , 0 0 0 0
9 Faculty Temporary 0 0 0 0
10 Academic Apprentice LJ Insert Comment 0 0 0 0
11 Academic Other B Format Cells.. 0 0 0 0
12 Career Staff 0 0 0 0
13 Non-Career Staff 0 0 0 0
14 -Total Salaries & Wages 0 0 0 0
15 Medical (Health/Denta 0 0 0 0
16 UCRS (Employer Contr Smart View » [ Expand/Collapse
17 All Other Benefits | 2553522 % Drill-th .
- By Drill-throug
18 -Subtotal Benefits Calibri |11 <A A $~% .. .
19 Fee Remissions £z Options.
20 Total Benefi B I >4
SR R Even Spread N
21 -Total Compensation 10870109 o
N N Spread using FY15-16 Actuals
22 Material and Supplies - General 0
23 Material and Supplies - Scientific 0 Spread using FY16-17 Budget
24 Communications 0 Roll-Up Calc (Optional)
25 Travel and Entertainment 0 0 0 0 0

The rule will run and your beginning budget will be spread to the quarters/months (depending on what form you
are using).

Data Validation

Data validation has been built in to the Beginning Budget Form and Budget Seasonality Quarterly/Monthly Form.
There are two types of data validation: Deficit Budget Check and Spread Check.

Deficit Budget Check

If you enter a budget that results in a deficit at the Ending Balance row, Total or YearTotal columns, the cell will
be highlighted in yellow. You may also notice a Data Validation Message, stating, “Please resolve the deficit
budget prior to submitting” when the cell is highlighted. You must correct the deficit budget; however, the
system will not prevent you from submitting deficit budgets for approval.
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0 0 0 0 0 0 0 0 0 L
21754 22506 32950 10024 11829 0 0 0 99062 0 .
| 1121260 967736 280728 1054926 285076 0 0 0 4909725 10270109
0 0 0 0 0 0 0 0 0
| 1121260 967736 880728 1054926 885076 0 0 0 4909725 10870109 1
| 6134138 -211493 502354 -946340  -843935 0 0 0 3630017  -10870109 T
| 2413185 0 0 0 0 0 0 0 2413185 ¢
(8547324 -211493 502354 -946340  -843935 0 0 0 60432025 -10870103)]

rPIease resolve the deficit budget prior to submitting. ‘f

Spread Check

The Budget Seasonality Form will also check for To-Be-Spread amounts for each input row. If the To-Be-Spread
amount is greater than 1 or less than -1 on a data input cell, the cell will be highlighted in yellow and a Data
Validation message stating, “Please adjust your spread to match the annual budget” will appear. All To-Be-
Spread issues must be resolved prior to submitting your budget.

BegBalance To-Be-Spr YearTotal +Q1 +Q2 +Q3 +24 $ Varia
Beg Budge Adjustme Budget Cu Program ¢ Chanc. Co Range/Me Total Budget Budget Budget Budget Budget Budget Propos
Perm Approp 0 ] 0 ] o 0 0 0 0 ] 0 ] 0
Temp Approp 0 o 0 o o 0 0 0 0 o 0 o 0
-Total Revenue 0 0 0 0 0 0 0 0 0 o 0 o 0
Faculty Ladder 5380876 i} 0 1] i} 0 5380876 0 5380876 1508464 1315443 1392369 1264600
Faculty Temporary 671768 o 0 i} o 1) 671768 0 671768 148166/ 132153 166590 224359
Academic Apprentice 623000 v} 0 1} o 0 623000 0 623000 49733 213011 159840 200416
Academic Other 962000 v} 0 1} o 0 962000 0 962000 238389 185597 245397 292617
Career Staff 667543 v} 0 1} o 0 667543 0 667543 151182 183815 183477 149069
MNon-Career Staff 11400 1] 0 1] o 0 11400 1] 11400 -192/ 5820 -1373 7144
-Total Salaries & Wages 8316587 0 0 1] 0 0 8316587 0 8316587 2095743 2035837 2046300 2138706
Medical (Health/Dental/Vision) 0 0 1] 0 0 0 0 0 0 0 0 0 1]
UCRS (Employer Contribution) 0 0 0 0 0 0 0 a 0 0 0 0
All Other Benefits 2553522 0 0 0 0 0 25535 !l 0 0 0 0 0
-Subtotal Benefits 2553522 o 0 o o 0 25535 : a 0 0 0 0
Fee Remissions 0 0 0 o 0 0 .
[P TR B 7 B 7 5 o o Please adjust your spread to match the annual budget
—Total Compensation 10870109 0 0 0 0 0 10870109 255 SniEred

Material and Supplies - General 0 o 0 o 0 0 o o a o 0 o 0
Material and Supplies - Scientific 0 0 0 0 0 0 1} o a 0 0 0 0
Communications 0 ] 0 ] o 0 0 0 0 ] 0 ] 0
Travel and Entertainment 0 0 0 0 0 0 1] 1] 1] 0 0 0 0
Services 0 i} 0 1] i} 0 1] 0 0 i} 0 i} 0
Consultants/Temp. Services 0 i} 0 1] i} 0 1] 0 0 i} 0 i} 0
Information Technology 0 o 0 o 0 0 1] 1] a o 0 o 0
Equipment (non computer) 0 0 0 o 0 0 1] 1] a 0 0 0 0
Operation and Maintenance of Space 0 0 0 o 0 0 1] 1] a 0 0 0 0
Student Support - Underg & Grad 0 0 0 o 0 0 1] 1] a 0 0 0 0
Other Expense - Control 0 0 0 0 0 0 o o a 0 0 0 0
Reserves for Auxiliaries 0 0 0 0 0 0 o o o 0 0 0 0
Indirect Cost Recovery 0 0 0 0 o 0 1] 0 0 0 0 0 0
-Total Operating Expenses 0 0 0 1] 0 0 1] 0 0 0 0 0 0
-Total Compensation and Operating 10870109 o 0 1] 0 0 10870109 2553522 8316587 2095743 2035837 2046300 2138706
Recharges 0 0 0 1] o 0 1] 0 0 0 0 0 0
-Total Expenditures 10870109 0 0 o o 0 10870109 2553522 8316587 2095743 2035837 2046300 2138706
-Surplus/{Deficit) R 1] 0 ] 0 0 -10870109 -2553522 -8316587 -2095743| -2035837 -2046300 -2138706
Carryforward 0 o 0 o 0 0 0 i} ] o 0 o 0
Ending Balance R 0 0 1] 1] I -10870109'—255352' -8316587 |-2035?43 -2035837| -2046300 -2138706

Approval Process

The Approval process will NOT take place in C-BIG for the 2018-19 Budget Year (same as 2017-18). C-BIG users
will be locked out of the system by the budget submission deadline: Tuesday, February 27, 2018 (end of day).
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Logging Off Smart View

To log off,

1. From the Smart View Panel, click on the down arrow next to the Home icon.
-

2. Select Disconnect All.

Smart View NS
Task List fa (= »
I
Home
Shared Connections
IE Private Connections B
e ck

o Document Contents =%
ol ®] TaskList

Smart Query
e . i Spr
e Predictive Planning

Disconnect All I

3. Close Excel.

Troubleshooting

In the case that an error message appears while inputting budget, or your data cannot be submitted, please
ensure that you have installed the latest version of Smart View. The latest version can always be found on the
APB C-BIG webpage under the Download Smart View section.

In addition, many errors result from incorrectly installing Smart View. When installing, please remember to
right-click the installation file and select “Run as Administrator”. Please uninstall a prior version (if found in the
Remove Programs section of the Control Panel — sometimes it is not, depending on the version) before installing
a new Smart View version.

Do not hesitate to contact the Hyperion Planning Analyst, Cathy Son (cson@ponet.ucla.edu), if assistance is
needed.
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